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Functions 
Microsoft Excel has several built-in functions. To insert a function, click the Insert Function 
button  on the Formula Bar, or the Insert Function option from the Formulas Tab. 
 

 
 

From here you can request a function to perform a particular task and Excel will make suggestions for 
you. If you Search for a function: Excel will return a Recommended category, offering all the functions it 
thinks might help in your search. 
 
By default, the first category is a list of Most Recently Used functions. To see all the functions built into 
Excel, you can choose All from the Select a category: list. 
 
The bottom of this window displays a description of the selected function. Each choice will show an 
example arrangement of the function, the arguments, and a description of what that function should do. 
If you need more information, click on the Help on this function option in the bottom left corner. If you 
have found the function you would like to use, select it and click OK. 
 
An easier way to access the list of Most Recently Used functions is to press the 
equal sign on the keyboard, as if you were going to type an equation. The name 
box, that displays which cell you are in, changes to the last function that was 
used. When you click on the arrow next to the listed function (in this case 
SUM), you will see a list of list of Most Recently Used functions. 
 

 becomes  
 
If the function you desire is not on the Most Recently Used list, chose the More 
Functions… option at the bottom of the list and you will get the above Insert 
Function dialog box. 
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Either selection method will open the Function Arguments window. 
 

 
 
The function name is listed in the top left corner and the description is across the bottom. There are 
blanks in the middle of the screen for the arguments of the statement. You can type in the cell 
addresses, move the window out of the way to try to select the addresses or let Excel help you move 
the window by using the Collapse or "go out and get it button" ( ). This button will collapse your 
Function Arguments window so you can select the data you wish to use as an argument in this 
function. Once you have chosen your desired data either press Enter or click on the Expand button (

) to return to the full window. 

 

 
In the sample above, you can see we can Sum more than one number/set of numbers. As soon as you 
click into Number 2 a Number 3 will appear. The description tells us this will allow up to 255 arguments 
(number ranges) to sum. 

 

Across the bottom of this window we can see a Formula Result =. This will show us the running total as 
we add in each part of the equation. Notice there is also an =number at the end of each argument line. 
This will give you a piece-by-piece result for each argument. This is especially helpful when using the 
logic functions, such as If. 

 

When you click the OK button, the answer to the equation should be displayed in the original cell. 
Double-clicking on the cell or pressing the F2 key on the keyboard will put this formula into edit mode. 
Excel color-codes which cells it is using in this formula. To bring back the gray edit box, click on the 
function button  on the formula bar. 
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Naming Cells 
Another way to ensure an absolute reference to a cell is to Name the cell, and use that name in your 
equation. The simplest way to define a cell name is to select the cell, erase the cell address within the 
name box, type the Name of the cell in the name box and press Enter. 

 

  
 

Once a name is defined, you can use it in your equations. 
 =B12*$B$1  means the same as =B12*FixedValue 
 
When you use the fill handle or the Copy/Paste feature, the B12 will change to be relative to the new 
location, but FixedValue will remain throughout, always pointing to cell B1. 
 
This same method can be used for a range of cells. Select the desired range, click within the name box, 
erase the current cell address, type the name of the range, press Enter. 
 
*NOTE* There are some limitations in naming. You cannot use many special characters such as the 
hyphen (-), and the name must be all one word, no spaces. In the example above, we used capitalization 
to show multiple words, you can also use the underscore character ( _ ). 

Good Names: fixedvalue FixedValue Fixed_Value 
Bad Names: fixed value Fixed Value Fixed-Value 

 
Defined Names group on the Formula Tab: 

• Define a Name – create a new name 
• Use in Formula – choose from a list of existing names, this can be used 

to begin a new formula or to add a name to a formula you are building. 
• Create from Selection – make a new name based on a group of selected cells 

 
Use the Name Manager to modify a Defined Name.  
 

• New: Create a new Name 
• Edit…: Rename, add a comment, change cell 

reference 
• Delete: Select the name in the list and click 

Delete to remove it 
• Filter: Filter the list of names to help you find 

the one you need. 
 
To Redefine: Select the name in the list, erase the Refers 
to blank and choose your new range of cells. Click the 
Check to accept. 
 
F3 is the keyboard shortcut to let you pick a name to use in your equation. 
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Class Exercise – Sales Report (Review) 
Create Data Table 

- Click on the Plus sign next to 
Sheet 2 to create Sheet 3 

- Zoom to 150% 

- Type in the table shown here 
 
 
 

 

Format Data Table 
- Bold Row 4 
- Center Column C 

- AutoFit Column C 
- Dollar Format the Prices, B5 through B7 
- In Cell D4 type: SubTotal 

o Should be bold already 

 
 

Calculate SubTotals 
- Enter First SubTotal  

o In Cell D5 Type: = B5*C5 
 $121,401.00 

- Each total is going to be the price of the item, times the Qty sold of the item. If we had 3,000 
records, we would not want to type the equation 3,000 times 

o Our equation is a pattern, "the cell two away, times the cell next to me" 

o Anywhere you copy or fill the equation, the pattern will follow 
- Use Fill handle to pull down this "pattern" 
- Switch to Formula view (Ctrl ~) to see results and switch back to normal view 
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Calculate Taxes 
- In Cell E1 type: Tax Rate 
- In Cell E2 type: 10% 
- In Cell E4 type: Taxes 

- In Cell E5 type: =D5*E2 
o Our pattern is Subtotal times Tax Rate 

- Use fill handle to pull down equation 
o Don't Panic, these answers are supposed to look weird 

 

Absolute vs Relative 

- What Happened? 
o Pattern "Cell next to me * Cell three above me" 

o As we move DOWN the pattern continues but it’s wrong for this equation 
- Erase the answers 
- In Cell E5 type the same equation: =D5*E2 

o Before you accept, press the F4 button on the keyboard to lock cell address E2 

o =D5*$E$2 
 you can type in the $ signs, but F4 is often faster 
 Think FORCE for the F4 button 

o D5 is relative (always cell next to me) 
o $E$2 is absolute (always cell E2) 

- Use fill handle to pull down the equation 

 
 

Calculate Totals 
- In Cell F4 type: Total 
- In Cell F5 type: = D5+E5 
- Use fill handle to pull down the equation 

 
  



 

8 
 

Calculate Grand Total 
- In Cell E8 Type: Big City Store Grand Total 

o From the Home tab, Align Right 
 If it won’t let you, make sure you have accepted your entry (enter or ) 

- Click in Cell F8 
- Use AutoSum button Sigma - ∑ in the Editing group 

on far right of the Home tab 
o =SUM(F5:F7) 
o In English, this reads "Calculate the Sum of F5 through F7" 

 

 
 

Note: When you click the AutoSum button Excel looks for numbers above the current cell. If it 
can't find a number, it will look to the left.  The AutoSum button has a drop down menu to do 
quick calculations for Sum, Average, Max, Min, and Count. 
 

Confirm your answer 
- Select cells F5:F8 
- Look at the status bar in the bottom right of the window to see the Average, Count, and Sum 

o Sum should be $740,183.40 
 

- Change the fill color for cells F5:F8 to yellow 
o These are now our "Yellow Numbers" 

 

Class Exercise – Functions 
Set up for Functions 

- In Cell C9 type: Grand Total 
- In Cell C10 type: Total Avg 
- In Cell C11 type: # of Items 
- In Cell C12 type: Largest Sale 

- In Cell C13 type: Smallest Sale 
- Right align all titles in cells C9:C13 
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Function Argument Window 
- Click in cell D10 

o We can tell we are in cell D10 because of the Name Box 
- Press the Equal Sign = 

o The Name Box has changed to a list of Most Recently Used Functions 
o Since the last function used on this computer is SUM, it’s listed first 

 
 

- Choose SUM 
o This will open the Function Arguments window 

 
o Clear the contents in the Number1 box 
o Move window so you can see the yellow numbers 

 To move: click in the title bar or any grey blank space and drag 
o Once you can see the yellow numbers, click in the first one, cell F5 

o Drag to the last yellow number, F7 
o Selection should be F5:F7 
o Click OK 

- Sum should be $740,183.40 
- Clear Cell D10 



 

10 
 

Search for Functions 
- In Cell D10 Type: = 
- Open the List of Recent Functions from the Name Box 
- Click on the last option, More Functions… 

o If you click on a function name, Excel gives a brief description.  
o Click on the Help on this function 

link for a Help article about this 
function, usually with examples. 

- Erase the "Type a brief description of 
what you want to do and then click Go" 
from the Search box. Type in ADD and 
click the GO button. 

- Select Sum from the list and click OK 
- This opens the same Function 

Arguments window  
o Choose your Yellow Numbers 

and Click OK 
- Sum should be $740,183.40 
- Clear Cell D10 

 
Editing a Function 

- Press the Equal Sign 
- Choose SUM from function list 
- Click OK 

o Answer should be WRONG 
o Why? Because we don’t have the yellow numbers 

- Click on the Edit Function box in front of the formula bar  
o This opens the Function Arguments window 

- Choose the Yellow Numbers and Click OK 

 
Other Basic Functions 

- Click in Cell D11 
- Press Equal Sign = 
- Click on List of Functions 

- Choose Average (aka Arithmetic Mean) 
- Choose Yellow Numbers and Click OK 
- Using Yellow numbers for each 

o In cell D12 calculate the Count 
o In cell D13 calculate the Max 

o In cell D14 calculate the Min 
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Final Result 

    
 

Class Exercise – Named Cells and Ranges 
Reset for next lesson 

- Clear the calculated taxes, Cells E5:E7 
o Notice how it carries through to all the answers 

- Clear the Grand Total in Cell F8 

- Clear the five functions you created in Cells D10:D14 
- Press Ctrl-Home to return to the top of the worksheet 

 
Naming a Cell 

- Click in cell E2 (10%) 

- Click in Name box 
o Erase E2 in Name box 
o Type TaxRate 

 No Spaces, No Hyphens, capitalization doesn't matter 

o Press Enter and TaxRate should still be in the box 
- Click anywhere else, see cell address in name box 
- Click on E2 (10%), see "TaxRate" in Name Box 
- Click anywhere else 
- Click arrow next to Name box and choose TaxRate 

o Should jump to cell E2 
- Go to Sheet 1, Click on Name box menu, Choose TaxRate 

o Should jump to Worksheet 3, Cell E2 
o We have made a "bookmark" in our workbook 

 
Using Cell Name in a Formula 

- In Cell E5 type =D5* 
- Click on cell E2 

o Instead of E2 we see TaxRate 

o TaxRate is always TaxRate, no ($) locks needed 
- Accept and fill down for E6 and E7 
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Naming Ranges 
- Select Yellow numbers 
- Type Total in the Name box and press Enter 

 
Using named cell in functions 

- Click in cell F8 
- Use AutoSum button Sigma - ∑ 

o =Sum(Total) 
- In Cell D10 type: = 

- Choose Sum from the List of Recently Used Functions 
- Select your Yellow numbers, you should get Total 
- Click OK 

 
Typing in Functions 

- Clear cell D10 
o In Cell D10 Type: =SU 

 See list of functions that start with an SU 
o Once you see the word SUM Select it 

 Double-click or press Tab (to GRAB!) 
o Continue to type: TO 

 See list of all functions and Names 
that start with TO 

o Double-click Total or tab 
o Press Enter to accept 

 
- Try the same for the other four functions. Type an equal sign, start typing the name of the 

function. Once you see it, double-click, or tab to grab the selection. Then type the first few 
letters of total. Double-click or tab to grab. Enter to accept. 

o Cell D11 the Average 

o Cell D12 the Count 
o Cell D13 the Max 
o Cell D14 the Min 
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Class Exercise – Adding Data and Redefining Names 
Working with Ranges of Data 
If we insert new data it must go inside the range 

 
- Insert two rows, one above item "C", one Below item "C" 

o Right-click on Row Number 7, INSERT 
o Right-click on Row Number 9, INSERT 

- Enter in data 
o In Cell A7 Type: D 
o In Cell B7 Type: 159 
o In Cell C7 Type: 951 
o In Cell A9 Type: E 
o In Cell B9 Type: 357 
o In Cell C9 Type: 753 

- Select Cells D5:F5 
o The first SubTotal through the First Total 
o The numbers should not change, just be selected 

- Use fill handle to pull down through all the yellow numbers 

 

- Note that the count in cell D12 says there are only 4 Items 

Included 
NOT 

Included 
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Redefining Names 
- From the Name box choose "Total" 

o Notice it refers to F5:F8. It included Item C in row 8 
because it was inside our previous range, but not 
item D in row 9. 

- Click in an empty cell 
- Turn to the Formula tab in the Ribbon 

- Look in the Defined Names group for the Name Manager 
- Choose Total from list 

o At the bottom of the window erase contents of Refers to: 
o Move window so you can see all the Yellow Numbers 

o Select the Yellow Numbers (=Sheet1!$F$5:$F$9) 
- Click the check box at the front of the line to accept 
- Click the Close button 

o Click Yes if it prompts you to save 

 
- The Sum of our Total is now over $1,000,000 so our columns widths may be too small.  

o Adjust Column width to read the ######## cells 
- The Count (# of Items) of our Total is now 5 
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Class Exercise – Freeze Panes & IF statements 
Freeze Panes 

- Click inside Cell B5 
- From the View tab in the Window group, choose 

Freeze Panes 

o This will lock the first four rows and the first 
column into place, so as you scroll through 
the worksheet you can always cee the content in those cells. 

 

If Function 
- In Cell G4 type: Continue 
- Draw Logic Tree 

o If our Total for this item is greater than $250,000, then yes we want to continue 
o If our Total for this item is less than $250,000, then no we don’t want to continue 

 
  IF Item Total > 250000 
  T F 

 
  Yes No 
 

- In Cell G5 type: = 

o From the list of functions choose IF and fill in the parts from our logic tree 
- Use fill handle to pull down the equation 
- Edit the function in cell G4 to 280000 
- DON’T FORGET TO: Use fill handle to fill down again 

Freeze panes above 
and to the left of 

THIS cell. (B5) 
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Bonus Exercise – Payroll Report 
 
Create Data Table 

- Insert a new worksheet  
- Zoom to 150% 

- Enter the data shown here 
- Format Titles to be Bold 
- Center Hours and PayRate 
- AutoFit Hours column 

 
 

Calculations 
 
Don't forget your $ (Force) to lock the Rate cells 
 

- Net Pay: Hours * PayRate 
- Deductions: Net Pay * DedRate 

- Gross Pay: Net Pay - Deductions 
- Total Net Pay: SUM(Net Pay) 
- Total Deductions: Sum(Deductions) 
- Total Gross Pay: Sum(Gross Pay) 

 

 
 
(Answers on the next page) 
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Calculations with Names 
- Name the Rate Cells  

o C2 – PayRate 
o D2 – DedRate 

- Name the Ranges 
o C5:C7 – NetPay 
o D5:D7 – Deductions 
o E5:E7 – GrossPay 

- Redo the calculations using the names instead of the cell addresses 

 
 

Final Result 
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